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Introduction

What is Control Center?
Control Center is the management center for the ClearCube enterprise. It is a feature rich console that
gives administrators the ability to manage PC Blade assets, monitor Blade health, build and deploy
agents to Blades throughout the enterprise.
ClearCube’s Control Center provides centralized management capabilities for all systems on the
network that have the Blade Manager 4.0 Client running on them. It provides the ability to:
•
•
•
•
•

Graphically display the entire enterprise in a tiered hierarchy
Display health and inventory information of each Blade in the enterprise
Perform remote systems management tasks including wake up, shutdown, and reboot of
Blades
Graphically create and deploy custom agents to a single machine or the entire enterprise
Log and export all events reported to the console from Blades

A major advantage of using ClearCube’s Control Center is the Graphical Agent Builder. The agent
builder makes it easy to create and deploy custom agents to a single Blade or an entire organization.
The agents make it easy to perform Blade health checks and automatically take the appropriate action.
Control Center also contains an alerting engine that can proactively notify an administrator of potential
Blade health problems. Finally, Control Center can launch all other components in the ClearCube
Management Suite (CMS) making it the ideal console for the entire enterprise.

Packaging
This manual is the most current version as of the initial release ship date for Control Center 4.0. For
free updated manual versions, please visit the Tech Docs section at http://support.clearcube.com.
Control Center requires that some components be installed prior to installation. All required
components are included on the Control Center 4.0 install CD.
The ActiveState Repository has a large collection of modules and extensions in binary packages that
are easy to install and use. To view and install these packages, use the Perl Package Manager (PPM),
which is included with ActivePerl.
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Installing Control Center

Installation
Modules
Control Center 4.0 can be installed on machines running Windows 2000 or Windows XP. The entire
package can be installed on one machine, and the management interface can be installed on multiple
machines so the Control Center database and alert server can be accessed remotely. Note the
required software listed below that must be installed, in the order listed, for Control Center to function
properly.
•

•

•

•

Java SDK version 1.4.2_03 - The correct Java version is provided on the Blade Manager CD
shipped from ClearCube. The version of a previously installed Java SDK can be checked in
Add or Remove Programs from the Control Panel or by running the following command at the
DOS prompt: “Java –version”. This should provide you with the installed Java version.
Blade Manager 4.0 requires Java version 1.4.1_02 or later. The Java 2 Enterprise Edition 1.4
SDK adds support for EJB’s, JSP’s, XML, and Web Services API’s in a single bundle.
Active State Perl 5.6.1 - The correct Perl version is provided on the Blade Manager CD
shipped from ClearCube. This should provide you with the installed Perl version. Blade
Manager 4.0 requires that Active State Perl 5.6.1 be installed on your machine. The ActiveState
Repository has a large collection of modules and extensions in binary packages that are easy to
install and use. To view and install these packages, use the Perl Package Manager (PPM)
which is included with ActivePerl.
ClearCube Distributed Computing Infrastructure (DCI) - The correct DCI version (2.0.8) is
provided on the Blade Manager CD shipped from ClearCube. Before installing Blade Manager
4.0, please make sure that the current DCI is installed. The installed DCI version can be
verified through the Add or Remove Programs from the Control Panel.
Apache Tomcat 4.1.27 - The Blade Manager Server and Alert Server components of Control
Center require an existing Apache Tomcat Server. Please make sure prior to installing these
components on a machine, the Apache Tomcat is already installed and configured.

Each prerequisite application listed above is included on the Blade Manager CD. To use the alerting
features of Blade Manager, ClearCube Control Center is also required.

Install Control Center
1. Install Control Center by running Setup.exe from the Control Center folder on the ClearCube
Control Center 4.0 CD.

2. The InstallShield Wizard will determine the disk location of installed DCI software to install
Control Center 4.0 Client.
3. Click the Next button to continue.
4. The Control Center License Agreement Screen will be displayed. Click the Yes button to accept
the license agreement.
5. On the Setup Type screen, choose the type of installation. To install all components, select
Typical. To choose specific components to install, select Custom. For example, select Custom
if a full Control Center installation is already installed on another machine and only a
management interface is needed. Click Next to continue.
6. The next screen will be the Select Features screen. Uncheck the boxes of any components
that are not needed. Below is a description of each component:

ClearCube Control Center 4.0 - This component is the management interface
needed to view the groups of machines, create and deploy agents, reboot
machines, etc. This interface can connect to a locally installed deployment or a
remote machine. This is the only interface the administrator sees.

ClearCube Trusted Machine - This component provides a layer of security.
This security module is a required path for creating, storing, and deploying
agents. Agents cannot be deployed to remote machines unless they are
configured (in Blade Manager) to accept updates from the Trusted Machine.

ClearCube Blade Manager Alert Server - This component sends alerts via
email or SNMP. The Alert Server is an independent component that has a web
services interface that allows alerts to be sent when certain thresholds are met
on machines running Blade Manager.

ClearCube Blade Manager Server – This component is the central
management repository for all Blades running Blade Manager. All data saved
through the console is actually kept in the Blade Manager Server repository and
is then queried by a Control Center Console during a session.
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Control Center Installation – Select Features

7. Check the appropriate boxes click Next to continue.
8. The next screen is the Choose Destination Location screen. If Apache Tomcat is installed
somewhere other than the default location, click the Browse button to find the webapps directory
under ‘..\Apache Group\Tomcat 4.1\’. Control Center components must be installed in this
directory. When the correct path is selected, click Next and installation will begin.
9. Once the installation is complete, click the Finish button. A system reboot will be required
before the installation is complete.

Uninstalling Control Center
1. To uninstall Control Center, from the Control Panel choose Add or Remove Programs.
2. Select ClearCube Control Center 4.0 from the list of programs.
3. Click the Change/Remove button.
4. Select the radio button for Remove. Click the Next button.

5. Once the removal is complete, click the Finish button.
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Setting Up Control Center

Launching Control Center
1. Launch Control Center by selecting Start Menu Æ All Programs Æ ClearCube
Management Suite Æ Control Center 4.0, as shown in the figure below:

Launching Control Center

Login to Control Center
The first screen in Control Center is the login screen. When logging in, there are
two options for authentication:
•
•

Local Authentication
Domain Authentication

Control Center will automatically detect the presence of a Domain Controller and will
populate the ‘Log on to’ pull down menu with the discovered domain(s), as well as the
local machine name. By default only a member of the Local Administrators group or the
Domain Users group can log in to Control Center.
Once in Control Center, you can elect to perform authentication locally or with domain
credentials by choosing Authentication from the File menu. Enter the username and
password, and then choose the appropriate authentication mechanism by specifying the
local machine or the domain from the ‘Log on to’ pull down menu. Next, in the Server
field, enter the name of the host where the Blade Manager Server is installed. Click the
Submit button to log in.

Control Center Login Screen
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Control Center will connect to the server and the following screen will appear.

Control Center Default Screen

Configuration
Blade Manager Server Configuration
Before Control Center can be used, the proper configuration must be entered.
From the Tools menu, select Configuration. The following screen window will
appear in the main frame.

BM Configuration screen

The information needed in each field is listed below. All fields are required with
the exception of the Switch Manager field. Holding the mouse over each field
will give a brief description of the information required in that field. If all
components of Control Center were installed on the local machine, Trusted
Machine and Alert Server should both contain the hostname of the local
machine.
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Trusted Machine

Enter the hostname or IP address of the
machine where the Blade Manager Server
is installed.

Alert Server

Enter the hostname or IP address of the
machine where the Alert Server is installed.

Subnet Range

Enter the subnet range of the machines you
wish to manage with this server. The
format is shown above; to enter more than
one Class C subnets, separate the subnets
with a ‘+’. NOTE: As a security measure,
to send Agents across multiple subnets, the
DCI service must run under Local
Administrator or Domain User login
credentials.

Switch Manager

Enter the hostname or IP address of the
Switch Manager server. This field is not
required.

Administrator Email

Enter the email address where you want to
receive alert emails.

SMTP Server

Enter the SMTP server hostname or IP
address if you want to use the email
alerting feature.

Alert evaluation interval (min)

The value in this field tells Control Center
how often to check Blades for alert
conditions. If the value is 30, it will check
each node every half hour.

Alert sleep time (hours)

The value in this field tells Control Center
how often to send an alert (e.g. email) if a
Blade has crossed an alert threshold and
stays in an alert condition. If the value is 1,
it will send one email every hour.

Click the Submit button to save the configuration

Using Control Center

Performing a Discovery
Before performing a discovery, the subnet field must be populated in the Tools>Configuration page. NOTE: As a security measure, to send Agents across multiple
subnets, the DCI service must run under Local Administrator or Domain User login
credentials.
To populate the console with Blades on the network, a discovery must be performed.
When a discovery is performed, all machines running Blade Manager 4.0 in the
configured subnet will be shown in a sorted tree in the left pane. To discover
machines click the Discovery button at the top of the window or select Discovery
form the Tools menu
.

Control Center Discovery

After the initial discovery, all node icons will have a blue screen and will face right. If
at some point a Blade becomes unreachable (powers down or loses network
connectivity) it will appear with a gray screen and will face left. Even after
communication drops, Blades will remain in the list unless they are deleted.
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Adding Tiers
To more easily identify and locate systems, Control Center provides a threetiered hierarchy of groups. The Tier hierarchy is as follows:
•
•
•

City
Location
Group

Adding a City
In the tree of discovered machines on the left, right click on Discovered Nodes at
the top of the tree. Select City from the pull-down menu. The following screen
will appear. Type in the city name (e.g. Chicago) and click the Add button.

Add City Node

Adding a Location
Right click on the city for which you want to create a new location and select Add
from the pull-down menu. Select Location from the drop-down menu. Enter the
Location (e.g. Northwest) and click Add.

Add Location Node

Adding a Group
Right click on the city for which you want to create a new location and select
Add from the pull-down menu. Select Group from the pull-down menu. Enter
the group name (e.g. Sales) and click Add.

Add Group Node

Adding Nodes to Tiers
Once the Tiers have been created, you can add systems to each Tier. Click and
drag the node to the Tier where it should be added.

Adding systems to a Node
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Deleting Tiers
To delete a Tier, simply right click on the Tier and select Delete from the pull-down
menu.

Renaming Tiers
To rename a Tier, right click on the Tier and select Rename from the pull-down
menu.

Rename a Tier

Enter the new name. Click the Submit button.

Connecting to a System
To connect to any node to view health and inventory information, double click on the
node in the left tree, or right click on the node and choose Connect form the pulldown menu.

Viewing Connection

The Blade Manager Client screen for that system will appear in the right pane.
You can use the selected system’s Blade Manager Client features from this screen. See
the Blade Manager Administrator’s Guide for more information on using the Blade
Manager interface.
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Systems Management
Waking Systems
To wake a system that is shut down, right click on the node and select Wake on
LAN from the pull-down menu. The Wake on LAN command can also be sent to a
group of machines. Right click on the Group/Location/City name and select Wake
on LAN. This will send the Wake on LAN command to all machines in that
Group/Location/City. NOTE: Some network switches block Wake on LAN packets
by default. This is a security measure many networking vendors are implementing.
If issues arise when using Wake on LAN features, please ensure that all
networking devices between hosts are configured to allow Wake on LAN packets.

Restarting Systems
To restart a system, right click on the node and select Restart from the pull-down
menu. The Restart command can also be sent to a group of machines. Right click
on the Group/Location/City name and select Restart. This will send the Restart
command to all machines in that Group/Location/City. A warning message will
appear on the clients machine giving the user thirty seconds to save before the
system restarts.

Shutting Down Systems
From the left pane, click on any system name to select it. The background will be
highlighted as shown. Right click on the highlighted system and select Shutdown
from the pull-down menu. The Shutdown command can also be sent to a group of
machines. Right click on the Group/Location/City name and select Shutdown. This
will send the Shutdown command to all machines in that Group/Location/City. A
warning message will appear on the clients machine giving the user thirty seconds
to save before the system shuts down.

Agents

Creating Agents
The agents within Control Center make it easy to monitor a Blade’s status
and automatically take the appropriate self-healing and notification actions
such as shutting down a system or sending an email to the administrator.
Agents are composed of three elements: sensors, logic operators, and
actions.

If Free Space
< 5 GB then

Sensor

Logic

Action

There are two types of Agents. The first type is a basic agent, which
consists of one comparison. The second type is a complex agent, which
includes two comparisons, which act as an “AND” condition for comparison
purposes.

Creating an Agent
Click the Agents button. The Agent window will appear in the main frame.
After choosing which component should be monitored, begin by clicking on
a Sensor object and dragging it to the canvas on the right.
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Select a Sensor

Next, drag the Comparison component onto the canvas.

Select a Comparison

Drag the appropriate Action onto the canvas.

Select an Action

Now the objects must be linked together and the thresholds must be set.
Begin by clicking on the Sensor object; then right click on the Comparison
object and select Draw a Line. Next, click the Comparison object and then
right click on the Action object; select Draw a Line. Right click on the
Comparison object and select Configure. Enter a value for the threshold.

Type in Threshold
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The final step is choosing an action. Right click on the Action object and
select Configure. Enter the email address and click the OK button.
The agent must be saved or the configuration will be lost. Click the Save
button at the bottom of the pane to save the agent.

Complex Agent Example
The following is an example of a complex agent which represents an “AND”
condition, e.g. disk space is less than the threshold AND Free Memory is
less than the threshold; send an email and reboot the machine.

Complex Agent Example

For an “OR” condition, you can deploy multiple agents (i.e. if disk space is
less than 10, send email; if memory is less than 256, send email). Once
you have multiple agents, named descriptively, you can deploy them to
multiple machines (city, location or group) simultaneously.

Deploying Agents
Agents can be deployed to one machine at a time or can be deployed to
many machines at once. To deploy an Agent to one machine, right click on
the node select Deploy Agents from the pull-down menu. To deploy an
Agent to multiple machines, select multiple machines using the Ctrl or Shift
keys, then right click and choose Deploy Agents from the pull-down menu.

Select an Agent

Select the appropriate agent to be deployed and click the Open button.
When the Open button is clicked, Control Center will allow you to view the
progress of the Agents being deployed. Click the Yes button to view the
deployment log window.

Deployment Log Dialog
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While the agent is being deployed, a pie chart will appear.

Deployment in Progress

Once the agent has deployed, the pie chart will reflect success and
failures in the deployment.

Deployment Status

Click the Detail button to view details of the successes and failures.
Click an Agent record in the upper pane to view complete details on a
system by system basis in the lower pane.

Details of Agent Deployment

NOTE: For email actions, the alert system will send an email according to
the interval set in the configuration (Tools->Configuration).

Modifying Agents
Once an agent has been modified, you must re-deploy it to the appropriate
systems. If the name is retained, the agent will overwrite the original agent.
To modify an existing Agent, Click the Agents button. When the Agents
window appears, Click the Saved Agents button.

Open a Saved Agent

Select the appropriate agent to be deployed and click the Open button.
Make any changes to the agent and click the Save button.
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Viewing Deployed Agents
To view Agents deployed on a machine, right click on the node in the left
tree and select Deployed Agents from the pull-down menu.
Right click on the highlighted system and select Deployed Agents from the
pop-up menu. The following screen will appear:

Viewing Deployed Agents

This view allows the administrator to delete deployed agents from a
machine. It also allows the administrator to disable or enable certain
deployed agents on the selected machine.

Viewing Event Logs
From the main screen, click the Event Logs button. The Event Logs
screen gives an overview of all the agents and alerts that have been
triggered on machines that have Blade Manager 4.0 installed. The Events
Log view also allows you to clear out selected or all events by clicking the
Delete button. It also provides the ability to export the event logs to a text
file in a CSV format.

Viewing The Event Log

Adding Navigation Buttons
Additional buttons can be added to the navigation area of Control Center
4.0. In order to add more buttons to the top navigational area of Control
Center, please edit the SkinDefinition.config file at the following location:
%CC_INSTALL_DIR%\BM4Console\LF\xx
Where %CC_INSTALL_DIR% is the location for the DCI installation.
Follow the following steps to add additional buttons.
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Step 1: Open SkinDefinition.config file in a text editor such as WordPad.
Step 2: Increment the QuickButtons number by the number of additional buttons
to be added.
Step 3: Add the following line after the last Button:
<Button5>Button Label</Button5>

where Button Label is the label for the button.
Step 4: Add the link associated with the button:
<ButtonAction5>link</ButtonAction5>
where link is the URL for the application you want invoked upon clicking
the button. Note: Do not add “ http://” to the beginning of the URL link,
it will be pre-pended automatically.
Step 5: Restart Control Center 4.0.

View of the SkinDefinition.config file

Once the changes have been made to the skinDefinition.config file and
Control Center has been restarted, the new button will appear in the
navigational area of Control Center.

Adding Buttons To Control Center

Clicking on this button will open the associated URL in a new browser.

30 • Alert Features

Control Center 4.0 Administrator’s Guide

How to Contact Support

ClearCube Technology
In the event you have any problems with your ClearCube software, please refer to our Web site or
contact ClearCube Technical Support for guidance.
support@clearcube.com

Email address to ClearCube Technical Support

support.clearcube.com

ClearCube Support Website

(866) 652-3400

Direct line in the US

+1 (512) 652-3400

Direct line from outside the US

Active Perl
Commercial support for ActivePerl is available through ActiveState at:
http://www.ActiveState.com/Support/Enterprise/
For peer support resources for ActivePerl issues see:
http://www.ActiveState.com/Support/

Acknowledgements:
ClearCube Blade Manager 4.0 utilizes ActiveState Perl technology.
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